FlexColor 4.5
Documentation Addendum
# Table of Contents

## Part 1: For All FlexColor Users ................................................................. 4
- How to Use this Document ........................................................................ 4
- System Requirements .................................................................................. 5
- Most Important Changes for All Users......................................................... 5
  - New Support for Instant Approval Architecture .......................................... 5
  - Gamma Slider Replaced by Midtone Slider .................................................. 6
- Instant Approval Architecture ..................................................................... 6
  - Standard Instant Approval Workflow ........................................................... 7
- Using the Detail Window ................................................................................ 11
  - Introduction ................................................................................................. 11
  - Opening the Detail Window ......................................................................... 11
  - Loading and Working with Images ............................................................... 11
  - Using Multiple Panes ................................................................................... 13
  - Using Zoom ................................................................................................. 14
- Modifying Images in the Thumbnail Window ................................................. 14
  - Setting the Scope of Affected Images ............................................................ 15
  - Setting the Scope of Changes Applied ........................................................ 15
  - Modifying the Current Preview ................................................................... 16
- Midtone Slider in the Gradation Window ...................................................... 16
  - Using the Midtone Slider ............................................................................ 16
  - Effects on Older 3F images ......................................................................... 17
- Keyboard Shortcuts ....................................................................................... 17

## Part 2: FlexColor for Cameras ................................................................. 18
- Most Important Changes for Camera Users .................................................. 18
  - Processed Images Are No Longer Saved in Camera 3F Files.......................... 18
  - 3F File Compatibility Issues for Camera Shots .............................................. 19
  - New Color Handling for Camera Captures ................................................... 19
  - New White Balance Handling for Camera Captures ...................................... 20
- White Balance Settings for Cameras ............................................................. 20
  - Using the Exposure and White-Balance Controls .......................................... 21
  - Working with White Balance Presets ............................................................. 22
- Importing Camera Images .............................................................................. 22
  - Import Scenarios .......................................................................................... 22
  - Import Window ............................................................................................. 23
  - Import Window Buttons and Controls ........................................................ 24
  - Load Window Buttons and Controls ............................................................ 25
- Using Reproduction Mode ............................................................................ 26

## Part 3: FlexColor for Scanners ................................................................. 29
- Scanning with 3F .......................................................................................... 29
  - Opening the Scan 3F Window ...................................................................... 29
  - File Names and Locations .......................................................................... 30
  - Auto TIFF Export ........................................................................................ 30
  - Choosing Setups .......................................................................................... 30
File Size Options ................................................................. 32
Using a Batch Feeder ............................................................. 32
Reading the 3F Scan Log ......................................................... 33
Preventive Maintenance for Scanners ................................. 33
Part 1: For All FlexColor Users

This part describes general information about working with FlexColor with all types of images, regardless of whether you are using a camera or scanner. All users of FlexColor should read this part.

How to Use this Document

FlexColor 4.5 includes the user manual written for FlexColor 4.0 plus this addendum, which explains the changes made since version 4.0. If you are already familiar with FlexColor 4.0, then all you need to do after upgrading to 4.5 is to read this document.

FlexColor operates slightly differently depending on whether it is connected to a scanner or to a camera. The same differences take affect when you are editing images taken with a scanner or camera, respectively. Many features, however, are identical for each type of capture; this means that users that switch between scanning and digital photography only need to learn one program. However, because many users stick to one type of capture (scan or camera), this addendum is divided into three main parts:

- **Part 1: For All FlexColor Users**
  Describes the new features that affect both camera and scanner users
- **Part 2: FlexColor for Cameras**
  Describes the new features that affect camera users and camera images only
- **Part 3: FlexColor for Scanners**
  Describes the new features that affect scanner users and scanned images only

If you only use FlexColor for one type of capture, then you can ignore the part of this addendum that describes the features you do not use.

If you have never used FlexColor before, then start by reading “Most Important Changes for All Users” on page 5 and, if you are using a camera, “Most Important Changes for Camera Users” on page 18. Then read the FlexColor 4.0 manual as you experiment with the system. Finally, refer to the rest of this addendum when you
notice that the software does not match the descriptions given in the 4.0 manual and/or after you finish reading the full manual.

**System Requirements**

To use FlexColor 4.5, your system must meet or exceed the following:

- Macintosh: Mac OS X 10.2.1
- Windows: Windows 2000 or XP
- RAM when using a scanner: 256 MB
- RAM when using a camera: 1 GB
- RAM when using a camera in microstep mode: 1.5 GB
- RAM when using an Ixpress 528C camera: 2 GB

If you are a digital camera user, then see also “3F File Compatibility Issues for Camera Shots” on page 19 for important details about file compatibility between newer and older versions of FlexColor.

**Most Important Changes for All Users**

This section points out some of the biggest changes and new features that will affect both scanner and camera users that are already familiar with FlexColor 4.0.

**New Support for Instant Approval Architecture**

FlexColor 4.5 now provides full support for the *Instant Approval Architecture* (IAA) system introduced with the latest Hasselblad digital cameras and Ixpress digital camera backs. Using this system, you are able to assign one of three approval levels (green, yellow or red) to each image. Consequently, FlexColor displays the approval level of each image, includes controls for modifying approval settings and also enables you to use approval levels as criteria when importing, sorting and filtering, etc.

Though the IAA system was primarily developed to enable digital photographers to organize their work in the field, the feature is now integrated throughout FlexColor and can therefore also be used with all scanner and studio-photography work.

Specific notes about how IAA has been integrated into FlexColor are given in the appropriate sections of the remainder of this document.
Gamma Slider Replaced by Midtone Slider

In FlexColor 4.0, the Gradations window featured a slider labeled Gamma, which provided a precise gradation adjustment that lightened or darkened the image in a consistent way that is compatible with color management. In FlexColor 4.5, this has been removed from the Gradations window and replaced by a midtone slider in the Histogram window. The function is the same, but this new control is more similar to controls used in other familiar programs, such as Adobe Photoshop.

If you open an old file or use an old setup, the gamma setting will automatically be converted to a new midtone setting that duplicates the effect of the old setting. For example, the previous default gamma setting of 2.2 converts to a midtone setting of 1.20; this default matches the assumptions of the color profiles that shipped with FlexColor 4.0. Note, however, that the new color profiles that ship with FlexColor 4.5 for both scanners and cameras are calibrated for a midtone value of 1.0; consequently, all of the new setups included with version 4.5 use the new color profiles and are preset with a midtone value of 1.0.

As a result of this change and other changes in the color-handling system for camera images, you need to make some extra adjustments when you open camera 3F files made with older versions of FlexColor (see also “New Color Handling for Camera Captures” on page 19); scanner images, however, are not affected unless you change the color profile from an old setup to use the new profile.

The Gamma setting from the Contrast tab of the Setup window has likewise been replaced with the Midtone setting.

For more information, please see “Midtone Slider in the Gradation Window” on page 16.

Instant Approval Architecture

FlexColor 4.5 now provides full support for the Instant Approval Architecture (IAA) system introduced with the latest Ixpress digital camera backs. Using this system, you are able to assign one of three approval levels (green, yellow or red) to each image. Consequently, FlexColor displays the approval level of each image, includes controls for modifying approval settings and also enables you to use approval levels as criteria when importing, sorting and filtering, etc.

Though the IAA system was primarily developed to enable digital photographers to organize their work in the field, the feature is now integrated throughout FlexColor and can therefore also be used with all studio-photography work and 3F scans.

Though you can use the system any way you like, the intention is that you should assign the levels as follows:
Part 1: For All FlexColor Users

Instant Approval Architecture

- Green for your best shots
- Yellow for images that need closer inspection
- Red for images that should probably not be used.

Standard Instant Approval Workflow

The standard method of working with the Instant Approval Architecture is as follows:

1. You take a 3F scan or digital-camera shot.
2. When you are working in the studio, FlexColor analyzes the shot to find out if it seems to be over- or underexposed. If it suspects a problem, it marks the image as yellow; otherwise it marks it as green. Note also that some images may trigger the warning even though they are exposed according to your intentions. You should consider these warnings only as a guideline.
3. When you are working with a digital camera away from your computer, the camera itself performs a similar analysis for assigning the initial approval setting and also provides controls for adjusting the approval level of each shot as you browse images using the camera LCD. Later, when you are importing images from your camera into FlexColor, you can sort and/or filter by approval level. (Note, however, that older Ixpress camera backs do not provide this feature.)
4. Approval levels are clearly shown for each image in the FlexColor Thumbnails window, where they can also be used for filtering and/or sorting. When you are reviewing your images, consider the approval level of each and adjust it as necessary. In the future, the approval levels will help guide you and others to the best images.
5. When you begin working to optimize and export your 3F images, use the approval status as a guide for organizing your work. For example, you might begin by opening and optimizing the green shots and then go to the yellow shots only if you still need more images and then, finally, check the red shots as a last resort.

Note that the system is very flexible so you can use it in any way that you like. For example, you can set FlexColor to assign all new images a yellow or green status regardless of the exposure warning.

Initial Approval Level

You are able to set the initial approval level for new 3F scans and camera shots to match the way you intend to use the approval system. To do this, open the Preferences window (select FlexColor > Preferences in Mac OS; File > Preferences in Windows) and go to the 3F tab. Use the Initial Approval Level pop-up menu to select your preferred of the following options:
Part 1: For All FlexColor Users

Instant Approval Architecture

- **Green**: all new shots and scans will initially have a green status.
- **Yellow**: all new shots and scans will initially have a yellow status.
- **Auto**: Each time you take a new shot or scan, FlexColor will analyze the image to see if it looks good (properly exposed, in focus, correctly framed, etc.). Images that pass the test will be given a green status; questionable images will be given a yellow status. This is especially useful when you are using a digital camera or batch feeder.

Newer Ixpress camera backs are able to perform a similar function when you are working away from your camera. See your camera back manual for details.

Approval Settings in the Thumbnails Window

Each of the thumbnails displays each image as though it were mounted as a slide. In the virtual mounting area, you can read various types of information about each image, including the image name and approval. The approval setting is shown in the upper left corner for each thumbnail.

![Figure 1: Approval-level displays and controls in the thumbnails window](image)

Note that camera shots show a number (either 1, 4 or 16) in the upper-right corner; this number corresponds to the shooting mode used on the shot (single or multi-shot). Scan images do not show a number, so you can also use this to tell scanned images from digital photos.
To change the approval status of any image, first select the image by clicking on it once, then click on the appropriate button in the tool panel at the left side of the window.

To filter the thumbnails by approval status, activate one or more of the filter buttons, which are in the tool panel at the left side of the window (see Figure 1, above, and Figure 2, below). The filters are additive, so if you enable both the green and yellow filters, then you will see both green and yellow images. If you enable all three, the effect is the same as enabling no filters.

![Filter buttons](image)

Figure 2: Examples of reading and reading the approval filter in the thumbnails window.

Use the **Sort by** pop-up menu to sort the thumbnails either by date or by name. You can further sort the images by approval rating by marking the ...and approval check box. When sorting by approval, all green images are shown on top, then yellow and finally red; within a given approval rating, the images are sorted according to your selection in the **Sort by** pop-up menu.

### Approval Settings in the Preview Window

When you are working in the main FlexColor window, you can see the approval rating of the current image at the bottom-left corner of the preview. To change the rating, click on this rating icon. With each click, the rating will cycle from green to yellow to red and back to green again.
Modify Thumbnail Setups by Approval Rating

The Modify function of the thumbnail window enables you to modify the settings for several images at once. You are able to control whether your changes will apply to all images, selected images or to all images of a given approval rating.

The Modify window has changed in several ways since FlexColor 4.0. See “Importing Camera Images” on page 22 for details, including how to apply settings by approval rating.

Import by Approval Rating

The Import function enables you to load images from your digital camera (or from a folder) after you have been shooting while not connected to your computer. When you do this, you can filter the import by approval rating; for example, you might only import your green shots.

The import function has changed in several ways since FlexColor 4.0. See “Importing Camera Images” on page 22 for details, including how to import images by approval rating.
Using the Detail Window

In FlexColor 4.5, the Detail window has been improved to support larger images and extended functionality. The description below fully replaces the section from the FlexColor 4.0 User’s Guide.

Introduction
The Detail window can show up to 4 detail views of the preview image (in 100 to 400%).

The detail views are especially useful when you want to see the effect of the corrections performed using the various correction tools in different areas of your preview image. It also gives you a zoomed view with which to use the various color pickers for highlight, shadow, white balance, etc.

Opening the Detail Window
There are many ways to open the Detail window:
- Type cmd-5
- Type the letter “d”
- Click on the Detail button in the Zoom area of the main FlexColor window
- Select Detail from the Window menu.

When you first open the Detail window, it contains a single pane, which is shown with a black border to indicate that that pane is active. While the pane is active, try to move your mouse cursor over the preview window; the cursor is now replaced with a box that indicates the area of the Detail window pane. To resize the pane, click and drag on the bottom-right corner of the Detail window—note that the size of the box at your cursor in the preview updates to match the new size.

Loading and Working with Images
To load an image into the Detail window, first set the window to the size you want, and then click on the part of the preview image that you want to load. The cursor remains active, so you can continue to click here and there in the preview to inspect various parts of your image.
Figure 4: Using the Detail window

Once an image is loaded into the Detail window, you can do the following:

- To move the image in the Detail window, hold down the space bar, then click and drag in any unlocked pane of the window.
- To set highlight, shadow and/or neutralization points using the Detail window, first activate the appropriate color picker (for example, by using a keyboard shortcut: “h” for highlight, “s” for shadow, “n” for neutralize). Then hold down the alt (option) key and click on the target point in the Detail window. Note that the cursor changes to show the color picker type when you hold down the alt (option) key. Note also that you cannot use color pickers in locked panes after you change image settings—this is because the image in the locked pane is no longer current.
- To lock a pane in the Detail window, click on the lock icon below the pane you wish to lock so that it shows a closed-lock icon.
- While the pane is locked, you cannot activate or move it; it will not update to indicate changes made with the other tools (such as the Histogram or Gradation windows). You can therefore use a locked pane to compare the before/after effects of your settings.
- Locked panes hold their image even if you open a new image in the preview window, so you can use them to compare two different images. When a locked
Part 1: For All FlexColor Users

Using the Detail Window

If a pane shows an image different from the current preview, the file name is shown under the affected pane(s).
- To unlock a pane, click the closed-clock icon so that it opens again. When you do this, the unlocked pane will immediately update to match the current preview and settings.

Using Multiple Panes

The Detail window can include up to four panes, enabling you to compare the effects of your settings at several different parts of the image. To add a new pane, click on the “+” button. Click on the “-” button to remove a pane (panes are removed from right to left).

![Image of Detail window with multiple panes](image)

Figure 5: Working with multiple panes in the Detail window. Note the before-after affect you can get by loading identical images into two panes (using alt-click), then locking one pane before making settings.

When several panes are present, you have a few more options:
- The pane showing a black border is currently active. This is the pane that will update if you click on the preview.
- Click on a pane to make it active. Only one pane can be active at a time.
- You cannot activate locked panes.
- You can view the panes horizontally, vertically or in a 2x2 square. Use the orientation pop-up menu to select between these options (see Figure 3, above).
- To load an identical image into all unlocked panes of the Detail window, hold down the alt (option) key and click on the preview. This is useful for
Part 1: For All FlexColor Users

Modifying Images in the Thumbnail Window

comparing the effects of your changes; for example, load identical images into two panes, then lock one pane and make settings in the **Gradation** window to compare the effects of your settings at the pixel level.

**Using Zoom**

You can use the **Detail** window at any of three zoom levels: 100%, 200% or 400%. Use the zoom-in and zoom-out buttons to set the current zoom. All panes show the same zoom level and even locked panes will update to match the current level if you change it.

**Modifying Images in the Thumbnail Window**

The FlexColor 4.0 user manual described how to use the **Modify** command of the Thumbnail window to apply setup and other changes to several images without opening them in the preview. This functionality remains essentially unchanged in FlexColor 4.5, but has been expanded to enable you to better control the scope of your changes. The discussion below assumes that you are already familiar with the basic features of **Thumbnails** window and the **Modify** command; see the FlexColor 4.0 user manual for complete details.
Part 1: For All FlexColor Users

Modifying Images in the Thumbnail Window

Setting the Scope of Affected Images

Before you open the Modify window, you can start setting the scope of images that you will affect by working in the Thumbnails window (e.g., by using select, search and/or filter), though this is usually not necessary. At most, you will affect the set of images that were shown in the Thumbnails window when you opened the Modify window.

Open the Modify window by clicking on the Modify button. Here, use the pop-up menu at the top to further define the scope as follows:

- Set to “Selection only” to apply your modifications only to the images you had highlighted before opening the Modify window.
- Set to “Images with Approval Level” to apply your modifications only to images of a given approval level. Then set the approval level using the three colored buttons next to the pop-up menu.
- Set to “All Images” to apply your modifications to all of the images that were shown in the Thumbnails window when you opened the Modify window.

Note that the number of images that will be affected as a result of your scope settings in both the Thumbnails and Modify window is shown to the right of the scope pop-up menu. Check this to make sure that you will get the scope you are expecting.

Setting the Scope of Changes Applied

When you use the Modify window to change the setups of your image(s), you are now able to modify the entire setups or just parts of them. For example, you might update just orientation to rotate several images 90°, but leave all other settings as they are.

To select which types of settings to update, expand the Setup section of the Modify window (if necessary) by clicking on the triangle next to its pop-up menu. Here, you can see a collection of check boxes, each of which is named for a type of setting. Mark the check box for each type of setting you want to apply to your selected images. For convenience, a Check All/Uncheck All button is provided.
Modifying the Current Preview
When you have loaded a 3F file into the main FlexColor preview window, you can modify its history from here, without needing to go back to the Thumbnails window. To do this, make whatever settings you want while working with the preview and then select Image > Modify from the menu bar. This opens the Modify window, which you can then use to modify the current image as described above.

Midtone Slider in the Gradation Window
In FlexColor 4.5, the Histogram window now features a midtone slider on the RGB graph. This slider replaces the old Gamma setting, which was in the Gradations window in FlexColor 4.0.

Using the Midtone Slider
The midtone slider appears in the RGB graph of the Histogram window. When you move the slider, you are adjusting the gamma curve for the image, which lightens or darkens the midtones without affecting the highlight or shadow points. The effect is similar to using the curve on the Gradation window, except that the shape of the gamma curve is strictly defined at each value, making it practical to use together with color management.

The default midtone value for the new setups included with FlexColor 4.5 is 1.00. This value is selected to match the new color profiles provided for Flextight Scanners and Ixpress Cameras. This value maps to the standard for defining the shapes of gamma curves.

To use the midtone slider, simply click and drag it to the left to lighten the image or to the right to darken it.

![Histogram Window](image)

Note that when you are using a scanner (or working with scanned images), then you can also use the Histogram window to adjust the highlight, shadow and midpoint...
 independently for each color channel. The midpoint controls for the independent channels do not implement a strict gamma curve, so the effects are slightly different (though similar). These midpoint values are therefore shown as pixel levels (0 - 255) rather than gamma values. Note, however, that you will rarely if ever use these controls because their effects are very difficult to predict accurately. When you are using a camera (or working with camera images), sliders are not provided for the independent color channels.

Effects on Older 3F images

3F images scanned or captured with an older version FlexColor will include setups that use the old gamma setting rather than the new midtone setting. They will also be using one of the old color profiles, which were designed to work with midtone 1.20 (gamma 2.2). When you open one of these images in FlexColor 4.5, the gamma setting will be translated to a midtone setting that has the same effect. Note, however, that the scales are different, so an old gamma setting of 2.2 translates to a midtone setting of 1.20.

For scanner images, your old color profiles will work fine, so you do not need to do anything special when opening an old file. However, for camera images, you must use the new profiles, which expect a midtone setting of 1.0 rather than the previous default equivalent of 1.2. You must therefore either update the 3F file to use one of the setups included with FlexColor 4.5 or change your existing setup to use the new camera profiles and then change the midtone to 1.00 to match. See “New Color Handling for Camera Captures” on page 19 for details.

Keyboard Shortcuts

In addition to the shortcuts listed in the FlexColor 4.0 manual, the following have been added in version 4.5 (all of which work without modifiers such as Ctrl.):

- **h**: activates the highlight picker for use in the preview or Detail window.
- **n**: activates the neutralization picker for use in the preview or Detail window.
- **s**: activates the shadow picker for use in the preview or Detail window.
- **d**: activates the detail picker and opens the Detail window.
- **c**: activates the crop tool for use in the preview window.
- **1**: sets the approval level for the current preview or selected thumbnails to green.
- **2**: sets the approval level for the current preview or selected thumbnails to yellow.
- **3**: sets the approval level for the current preview or selected thumbnails to red.
Part 2: FlexColor for Cameras

Most Important Changes for Camera Users

This section points out some of the biggest changes and new features that will affect camera users that are already familiar with FlexColor 4.0.

Processed Images Are No Longer Saved in Camera 3F Files

In FlexColor 4.0 and earlier, 3F files captured using an Ixpress digital camera contained both the raw camera image and a full-size, processed version of the image. Among other things, this made some exports faster and enabled FlexColor to provide 1:1 pixel zoom in the preview window. However, this came at the cost of larger 3F files and added complexity in the 3F workflow. We have therefore decided to stop storing processed images with the 3F files. You should ignore all references to this feature in the FlexColor 4.0 User’s Guide.

When you open an older, camera-generated 3F file (that includes a processed image) in FlexColor 4.5, you will be asked if you would like to remove the processed image to save disk space. You can choose to leave the processed image, but it will not be used for anything.

To compensate for this change in the 3F workflow, the FlexColor Detail window (which is still able to zoom in to 1:1 pixels and closer) has been enhanced in several ways. For example, you can now load much larger portion of your image into this window and use it for selecting highlight and shadow points. See “Using the Detail Window” on page 11 for a complete description of how the Detail window works in FlexColor 4.5.
This issue does not affect 3F files captured using a scanner, which never contained a processed image. With scanner files, you can still zoom in to the pixel level using the preview window.

**3F File Compatibility Issues for Camera Shots**

Because the 3F file format has been updated for FlexColor 4.5, we recommend that you do not move files between FlexColor 4.0 and 4.5. If you must work with old images in both versions of FlexColor, then work on copies when opening your files in FlexColor 4.5.

When you open an older file in FlexColor 4.5, the format is automatically updated to version 4.5. If you are opening a scanned file, then you do not need to do anything more. However, if you are opening a camera file, then you must manually adjust the ColorSync and gamma setup to work correctly with the new color-handling system for cameras; see “New Color Handling for Camera Captures”, below, for details.

New 3F images created using FlexColor 4.5 cannot be opened by previous versions of FlexColor. However, older 3F images that have been opened and modified in FlexColor 4.5 can be moved back to FlexColor 4.0 (though this is not recommended). The first time you open an older 3F file in FlexColor 4.5, the older file will automatically be updated to the new format. However, if you then switch back to FlexColor 4.0, the preview will look too dark; you can fix this by using the neutralization picker in FlexColor 4.0 to re-neutralize the preview. If you then move the same image back to FlexColor 4.5 again, you will see the opposite effect—the preview will be too bright. In this case, update the preview by holding down the alt and command keys (Mac OS) or Alt and Ctrl keys (Windows) and using the neutralization picker. The modifier keys ensure that the preview will be recalculated.

**New Color Handling for Camera Captures**

In FlexColor 4.5, the color handling system for camera captures has been redesigned. As a result, the program includes new color profiles for all cameras, each of which is designed to work with a midtone setting of 1.0. The older profiles were designed to work with a midtone of 1.20 (corresponds to gamma 2.2).

As a result of these improvements, you must take a few extra steps when opening 3F files captured with earlier versions of FlexColor. As mentioned above, you will be notified each time you open a file in FlexColor that includes a processed image—however, you will not be notified if no processed image is present.

Do one of the following each time you open an older 3F camera image in FlexColor 4.5:

- Unless you have already created a detailed custom setup for the image, select one of the new factory presets from the **Setup** menu in the main FlexColor
window. Then work with the various image-correction tools as needed and export.

- If instead you want to keep most of your previous setup customizations, then you must make a few adjustments to make the older file work correctly with the new color-handling mechanism for camera images. Do the following:
  1. Select File > Setup to open the Setup window.
  2. Go to the ColorSync tab of the Setup window and set the Input profile to “Hasselblad RGB”. This is the profile you should always use when shooting with an Ixpress camera. It is automatically selected in all of the new default camera setups.
  3. Click on OK to save your changes.
  4. Open the Histogram window and adjust the new mid-tone slider to a value of 1.0. This slider replaces the older gamma setting from FlexColor 4.0 and the value of 1.0 is the default expected for the new color-handling system (initially, it will probably be set to 1.20, which matches the gamma value used by the old profile and color-handling system.) You can adjust this later if needed for your image, but start with this default value of 1.0.

**New White Balance Handling for Camera Captures**

The white balance for camera captures is now established as a set of parameters in the setup rather than being defined globally in the 3F file as they were previously, where they were also device dependent. When using a camera or opening a 3F file created by a camera, the FlexColor window now includes a set of presets and a set sliders for fine-tuning the presets. A new exposure correction slider is also provided. See “White Balance Settings for Cameras” on page 20 for details.

As a result of this new approach, you should be careful when using a neutralization preset made with FlexColor 4.0. The old preset will be converted to the new system, but the conversion algorithm assumes that you are using an Ixpress camera (the old presets are device dependent). In general, we recommend that you make new presets.

**White Balance Settings for Cameras**

3F files captured using an Ixpress Camera back contain the raw mosaic image (or images) from the camera-back CCD. The file also includes values that describe how this raw data should be combined into a standard 3-color image for display and export. Because this processing data is stored as values in the image, rather than applied directly, you are able to adjust the white balance at any time—even after shooting. In images that have been combined and exported, it is much more difficult to correct the white balance.
For scanned images, there are no white-balance controls. This is because the precise qualities of the light in the scanner are known and encoded into the Flextight input color profile, so further control is not needed—images are always scanned to look exactly as they did on film. To modify these colors in your scans, use the standard Gradation, Histogram and/or Color Correction controls of FlexColor.

![New settings for cameras:](image)

**Figure 6: New settings for camera images in the FlexColor window.**

### Using the Exposure and White-Balance Controls

Whenever a camera is connected or a camera image is loaded, the control bar on the left side of the preview window shows four controls for working with the white-balance and exposure-correction values. Your settings will be saved with the file; when opening camera images, the values shown are those set when the image was taken (regardless of whether you shot them tethered or untethered from your computer), but you can change them at any time and save them back with the file as part of the setup history.

The following white-balance and exposure-correction controls are provided:

- **Exposure Correction** slider: use this slider to brighten or darken the image uniformly by up to 2 f-stops in either direction. This is the best way to correct for overall exposure—far preferable to using gradation curves or highlight/shadow settings for this purpose.
Part 2: FlexColor for Cameras

Importing Camera Images

- **Temperature**: use this slider to set the color temperature of your lights.
- **Tint**: use this slider to adjust the color tint of the image.
- **White Bal.** pop-up menu: this menu includes several white-balance pre-sets. When you select a value here, the *Temperature* and *Tint* values will be adjusted as specified by your selected preset. See also the discussion below.

**Working with White Balance Presets**

Use the **White Bal.** pop-up menu to load preset values for the *Temperature* and *Tint* controls. There are several types of entries in this menu:

- **Create** and **Delete** entries: use these to manage your own set of user presets. When you select **Create Preset**, you are asked to enter a name, which will then stored as a user preset with the current temperature and tint settings. If you no longer need one of your user presets, first activate it using the menu, then select **Delete Preset** here.
- **As Shot**: all new shots have some type of setting for temperature and tint. Select this entry to return these settings to the values they had when the shot was originally taken.
- **Auto**: select this entry to set the temperature and tint based on an analysis of the current photo. The resulting values will be slightly different for each picture. This function works best with photos that contain a full range of tints without a heavy intentional cast.
- **Factory presets**: below the **Auto** entry is a set of several presets named to match typical lighting situations. These match the selections offered by Ixpress camera backs when shooting in the field. You cannot delete these.
- **User presets**: if you have saved any of your own presets, then these are listed in a division under the factory presets. You can freely add or remove entries here using the **Create Preset** and **Delete Preset** entries of this menu.
- **Custom**: this entry becomes active whenever you adjust the *Temperature* and/or *Tint* sliders manually. If you choose this entry from the menu, it becomes the active selection, but the temperature and tint value initially remain unchanged.

**Importing Camera Images**

**Import Scenarios**

The procedure for importing images taken with an Ixpress camera varies according to which solution you are using. The following rules apply:

- When shooting away from your computer, newer cameras (including the Hasselblad H2D camera and Ixpress CF and CFH camera backs) save images locally using the DNG format, which is a raw camera format developed by Adobe.
When shooting away from your computer, older Ixpress cameras save images using a proprietary raw-file format on the Image Bank.

When you shoot connected to your computer, all of your shots are saved only as 3F files on your hard disk. They are not saved on your CF card or Image Bank.

When you connect your camera, camera back or image bank to your computer, the **Import** window will usually appear automatically, showing the contents of your camera or Image Bank.

Some cameras can be configured to look like standard hard disks when they are connected to your computer. When configured in this way, the **Import** window will not appear automatically. You must therefore open it manually (for example, by selecting **Window > Import** from the menu bar) and then navigate to the camera storage medium, which to your computer will look like a hard disk.

During the import, your images will automatically be converted to 3F and saved locally.

You can copy camera images using the computer file system rather than FlexColor if you prefer (e.g., using a CF card reader rather than connecting the camera). You must then use the **Import** window in FlexColor to convert the images to 3F.

### Using the Import Window

To import your raw camera shots, regardless of which raw format they use, do the following:

1. Do one of the following:
   - Connect your camera or Image Bank to your computer. Often, the **Import** window will open automatically (depending on your computer and camera settings).
   - Open the **Import** window either by clicking on the import button in the main FlexColor window or by selecting **Window > Import** from the menu bar.

2. The **Import** window opens.

3. If the images you want to import are not already shown, then use the pop-up menu at the top of the window to select the folder where they are stored or select “Choose Location” to navigate to a folder. Note that this menu lists your most recently used folders and enables you to add or remove favorite locations that you use often.

4. Inspect the images now shown in the **Import** window. Use the various controls provided to inspect, approve, sort, filter and select the images as required for the import you wish to make (see also “Import Window Buttons and Controls”, below).

5. Do any of the following to import the images:
Click on **Load** to open the **Load** window. This window provides more
scope controls and enables you to establish the initial setup, name and
numbers for the imported image(s). See also “Load Window Buttons and
Controls” on page 25 for details.

- Double-click on an image to import that image and open it in the preview
  window. (Or select an image and click on the **Show** button to do the same
  thing.)
- Drag one or more selected images from the **Import** window to the
  **Thumbnails** window.

6. The images are loaded and convert them to 3F. They will be saved in your
   current image folder, which is the one shown in your **Thumbnails** window.

**Import Window Buttons and Controls**

The controls of the **Import** window are similar to those of the **Thumbnails** window.

The following buttons and controls are provided:

- **Location**: this pop-up menu, located at the top of the window, enables you to
  select the folder from which you will import. The menu lists your most
  recently used folders and enables you to add or remove favorite locations that
  you use often. Select “Choose Location” to open a browse window with which
to navigate to and select a new folder.
- **Get Info**: displays details about the currently selected image.
- **Delete**: permanently deletes the currently selected image(s).
- **Show**: imports the currently selected image into the currently active 3F folder
  (this is also the folder currently shown in the **Thumbnails** window) and shows
  opens the image into the preview window. This button is inactive when more
  than one image is selected.
- **Load**: opens the **Load** window, which enables you to apply filters and change
  options as you import images. The 3F images will be saved in the currently

---

*FlexColor 4.5 Documentation Addendum*
active 3F folder (this is also the folder currently shown in the **Thumbnails** window). See “Load Window Buttons and Controls”, below, for details.

- **Update**: updates the selection of images shown in the **Import** window. Use this if you have used the file system to modify the contents of the import folder while the **Import** window was open.
- **Approval assignment buttons**: reassign the approval level of the selected images.
- **Approval filter buttons**: restrict the set of images shown in the **Import** window. You can select one, two or all three filters. Images hidden by the filter will not be imported. See also Figure 2 on page 9.
- **Include transferred**: mark this to include images that you have already imported. Clear this box to hide them.
- **Search**: to restrict the set of images shown in the **Import** window, enter text here. Only images that include the text you enter will be shown. Hidden images will not be imported.
- **Sort controls**: Use the **Sort by** pop-up menu to chose to sort by either date or name. Use the button next to the window to control whether the images should sort by ascending or descending values. Mark the **...and approval** check box to further sort by approval level, with the other sort settings acting as secondary criteria.
- **Size**: Use this pop-up menu to set the size of the thumbnail images shown in the **Import** window.

You can select images in the **Import** window by doing any of the following:

- Single-click to select a single image
- Shift-click to select a range of images between the currently selected image and the image on which you click.
- Command-click (Mac OS) or Ctrl-click (Windows) to toggle the select status of any image.

**Load Window Buttons and Controls**
The **Load** window enables you to fine-tune your image selection for import. It also enables you to apply initial settings to the imported image.

The following controls are provided:

![Load Images](image)

The following controls are provided:
**Scope controls**: use the pop-up menu at the top of the window and its accompanying controls to set the scope of the import. At most, you can import all of the images that were shown in the **Import** window (after filtering) just before you opened the **Load** window. Choose one of the following:

- Set to “Selection only” to apply load only to the images you had highlighted before opening the **Load** window.
- Set to “Images with Approval Level” to load only images of a given approval level. Then set the approval level using the three colored buttons next to the pop-up menu.
- Set to “All Images” to apply your modifications to all of the images that were shown in the **Import** window when you opened the **Load** window.

Note that the number of images that will be affected as a result of your scope settings in both the **Import** and **Load** windows is shown to the right of the scope pop-up menu. Check this to make sure that you will get the scope you are expecting.

**Initial Setup**: select the initial FlexColor setup to assign to each image. This will establish all of the initial image settings not already set by your camera.

**Change name**: to change the file name during import, mark this check box and enter the name you wish to use in the field provided. All of the imported images will use this name, plus a unique number taken either from the number assigned by the camera or starting with the number you enter in the **Renumber from** field.

**Renumber from**: to change the numbering from that applied by the camera to a new, unbroken series of integers, mark this check box and enter the first number to use here.

**Delete after transfer**: mark this box to delete the original files after they are transferred. Clear this box to keep your original raw files.

Once you have made your settings, click on **Load** to load the images and convert them to 3F. The images will be saved in your current image folder, which is the one shown in your ** Thumbnails** window.

### Using Reproduction Mode

A new option for camera users is to set the color correction to *reproduction mode*, which uses a linear film curve and applies color handling that aims to create the most accurate reproduction possible. This option is intended for applications such as art reproduction because the results are as close as possible to the original, as opposed to being optimized for depth, tonal range and skin tones.
During standard operation (when not using reproduction mode), colors are mapped in a way that is most appropriate for everyday photography. An important feature of this processing is its emphasis on reproducing pleasing skin tones for all types of skin. The result still provides extremely accurate color reproduction, but also more attractive skin tones. In addition, a film curve is applied to provide correct exposures with the current ISO setting.

When using reproduction mode, however, color reproduction is perfectly linear, which provides the most accurate and mathematically correct color reproduction possible. Images will have lower contrast and the sensitivity drops by about one third of an f-stop. Therefore, if you want to use reproduction mode, we advise that you capture with it already turned on rather than capturing in normal mode and then switching during postproduction. It is possible to switch later, but you will have less control over highlight exposure and might risk a loss of detail in these areas.

Note that when you use reproduction mode, the linear film curve means that it is extra important to use the correct exposure. To avoid loosing highlight information, we recommend exposing for the whites instead of the midtones.

Reproduction mode is not available when scanning or editing scanned images.

To set FlexColor to reproduction mode, open the Color Correction window (e.g., by selecting Window > Color Correction from the menu bar) and mark the Reproduction mode check box.
Figure 7: Effects of reproduction mode when shooting flat artwork. Note the shift in the histogram
This part provides information about how FlexColor works when connected to a scanner and/or when working with scanned images. If you never use FlexColor with a scanner or scanned images, then you can ignore this part.

Scanning with 3F

The procedure for scanning images to 3F files is approximately the same in FlexColor 4.5 as it was in FlexColor 4.0. However, the feature has been revised and expanded somewhat. See the FlexColor 4.0 User’s Guide for a general discussion about using 3F, but refer to the sub-sections below for details about the various settings available in the new Scan 3F window.

Opening the Scan 3F Window

To scan to 3F, you must use the Scan 3F window, which is only available when you have a scanner connected to your computer.
To open the window, click on the 3F button in the tool panel on the left side of the main FlexColor window.

**File Names and Locations**

Use the settings at the top of the Scan 3F window to control where your 3F files will be stored and how they will be named.

- Use the 3F File Destination setting to select a parent folder in which to save your 3F files.
- If you would like to create a new sub-folder each time you use the Scan 3F window, mark the Add job folder check box. Then, each time you begin a new 3F batch scan, FlexColor will create a new sub-folder below the Destination folder and save the new scans there. Either way, the contents of the most recently used folder will be displayed in the FlexColor Thumbnails window immediately after the batch is finished. This function is most useful when you are using a batch feeder to scan many images at once.
- Use the Image Name field to specify a name for your image(s). Each image will be given a name based on this value plus a unique number, which ensures that each image will have a unique file name when you are scanning a batch.

**Auto TIFF Export**

If you like, you can automatically export TIFF versions of your scans as you make them. Each scan will then produce both a 3F file for your archive, plus a TIFF file in which the default setup (plus optional auto-crop and/or auto-level settings) have been permanently applied. The TIFF files will be saved in a sub-folder automatically created below the destination or job folder established above.

To enable this auto-export feature, mark the Save final TIFF’s check box.

**Choosing Setups**

Use the pop-up menus in the middle of the Scan 3F window to establish the setup for the scan. These settings will control the initial appearance of your 3F files, but you can change these later before exporting. The following controls are provided:

- **Film Type**: select the type of original you are scanning (auto, positive, negative or black & white negative). When you use the auto function, the scanner will analyze the image and then decide if it is a color positive or color negative; it will then use the setup you have selected from the Positive Setup or Negative Setup pop-up menus, as appropriate. The auto function cannot detect black & white negatives (it will probably apply the positive setup if you try it), so you should scan these separately. The selection you make here will affect the selection of setups available in the Scan 3F window.
- **Setup**: this setting is only available when you set the Film Type to something other than “Auto”. Use it to select the setup that you wish to apply to your 3F
scan(s). The setups listed in this pop-up menu will only be those that match the film type you have selected; for example, if you set **Film Type** to “Positive”, then you will only see positive setups in the **Setup** pop-up menu.

- **Positive Setup**: this setting is only available when you set the **Film Type** to “Auto”. Use it to select the initial setup that you wish to use for images that the auto function identifies as color positives.

- **Negative Setup**: this setting is only available when you set the **Film Type** to “Auto”. Use it to select the initial setup that you wish to use for images that the auto function identifies as color negatives.

- **Frame**: set this to match the format of original holder you are using. For most new scanners, you can set this to “Auto”, in which case the scanner will detect the format automatically. If you scanner does not support this, or if you do not want to leave this up to the scanner, then select the appropriate holder from the list provided. Note also that this option may not be available for some combinations of equipment and settings, such as when a Batch Feeder is attached and enabled (in which case auto frame detection is always used).

- **Crop**: use this function to control how the image(s) should be cropped. Choose one of the following:
  - **Full size**: no crop will be made
  - **Auto**: the software will detect where the edge of each original is and crop the image accordingly. If you would like to crop slightly inside or outside of this, then use the **Bleed** field to control how far to modify the crop (in mm on the original surface). Use a negative bleed to make the crop smaller; positive values make it bigger. This results in a full-sized 3F file in which a crop is already defined for export.
  - **Current Crop**: uses the crop size and position currently set for the preview. This results in a 3F image that only includes the area inside the current crop, thereby reducing the size of your 3F file. Note that you must make the current crop based on an actual preview, not on a 3f file loaded into the preview window. Note also that when you select this option, the **Frame** setting becomes disabled; this is because the frame must be the same as the one used in the preview to set the crop. If you are using a Batch Feeder (which means that the frame might change between scans of the batch), then you should only use this setting if all of your frames are the same, otherwise problems may occur, such as incorrect crops and even situations in which short holders are drawn all the way into the scanner.

- **Auto levels**: if you would like to modify the default setups for each image using the adaptive FlexColor auto function, then mark this check box. The result will be a fine-tuning of the highlight and shadow settings based on a software analysis of the image inside the crop.

Note that the various auto settings are most useful when you are using a batch feeder to scan a batch that includes originals of varying sizes and formats.
Part 3: FlexColor for Scanners

Scanning with 3F

File Size Options
Beneath the setup options, the **Scan 3F** window includes a group of settings that enable you to control the size of your 3F files. Usually, you should use a **Scanning Resolution** of 100%, which ensures that your 3F files will contain the full scan data possible with your scanner for each original format, allowing for maximum flexibility in the future. However, if you are short on disk space and are sure that you do not need full resolution images, you may consider reducing this value or setting a maximum size. Alternatively, if you are sure that you will use your scans for just one specific purpose with known dimensions and resolution, you might use the **Adapt to format** settings.

The following settings are provided to enable you to set the size of your 3F files:

- **16-bit Size**: To limit the maximum size of your scans, set this field to your preferred size. This is the size of your 3F files, not the size of the TIFF or JPEG files you will export from the 3F.
- **Scanning Resolution**: To scan to a fixed fraction of the full resolution for each format, enter a percentage value here.
- **Adapt to format**: As an alternative to the controls above, you can instead set your scans to fit to a specific output size. To use this option, mark this check box and then specify your output size using the height and width fields provided next to the check box.
- **Output PPI**: Set this to the output resolution you would like to define for the file. Depending on your other settings, this may or may not affect the size of your 3F file. For example, if you are using **Adapt to format** to establish a size in cm, then your output PPI will affect the number of pixels in the image and therefore the scan size. However, if you are not using **Adapt to format**, or if you are specifying output dimensions in pixels, then the PPI simply becomes a definition in the file that does not affect the number of pixels it contains.

Note that as you change the various size settings, other fields are updated to show the effect. For example, if you lower the **Scanning Resolution**, then the file size and dimension values also decrease to show the effects of your new setting.

Using a Batch Feeder
If you have a feeder attached, then the **Scan 3F** window may also include a section of settings for controlling the feeder. The settings available will vary according to which type of feeder you have. See the documentation for your batch feeder for details about how to use the settings provided here.
Reading the 3F Scan Log

FlexColor keeps a log of each 3F scan that you make using the Scan 3F window. This is mostly useful when you are using a batch feeder because, in this case, you might set up a batch and then leave the scanner for up to an hour. When you come back, you can quickly see a record that indicates the location of your scans and shows if any errors occurred during the batch. The log is erased each time you quit FlexColor.

To view the log, select Window > 3F Scan Log from the FlexColor menu bar.

![3F Scan Log window features](image)

Figure 8: Features of the 3F Scan Log window.

Preventive Maintenance for Scanners

To ensure that Flextight scanners continue to provide maximum-quality scans, their mechanical components must be adjusted every year, every 25,000 standard scans or every 15,000 batch-fed scans, whichever comes first.

To help remind you of when it is time to return your scanner for preventive maintenance, the scanner stores a record of when it was last serviced and how many standard and batch-fed scans it has made since then. You can check this record for the currently attached scanner at any time by funning FlexColor and selecting Maintenance > Preventive Maintenance from the menu bar.
In the **Preventive Maintenance** window, you can read the following information:

- **Timeline**: the indicator and colored bar at the top of the windows show how far along you are until you should send your scanner in for preventive maintenance. When the indicator reaches the yellow or red parts of the bar, the **Preventive Maintenance** window will begin to appear automatically each time you start to use the scanner.

- **Warnings**: these appear below the colored bar only when your time is running out. When the indicator is in the yellow area, a notice is shown. When it is in the red area, a warning is shown.

- **Last service date**: this is the date on which the scanner was last serviced.

- **Scans without feeder**: this is the number of standard scans that you have taken since the last service.

- **Scans with feeder**: this is the number of scans that you have taken using the Batch Feeder and or Slide Feeder since the last service.

You should start to plan to send the scanner in for maintenance when the indicator in the **Preventive Maintenance** window reaches the yellow area. When it reaches the red area, you should send the scanner in as soon as possible.